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Important: Registration
Please complete your registration card and mail it today or use the online registration software provided with
Adobe Acrobat to register your copy. You must register to receive technical support and important product
update information.

Serial Numbers
If you have purchased an Upgrade version of Acrobat, please use the Serial Number from your previous
version of Acrobat.

If you have purchased a new copy of Acrobat, you can find the serial number on your registration card. Use
this new number to initialize the program. Do not use the number on the bottom of the Adobe Acrobat box,
since this serial number does not include the checksum required for serial number validation. If your serial
number does not work, please contact Adobe Customer Support.

System Requirements
System Requirements for Acrobat 4.0 Windows
- i486 or Pentium processor-based personal computer (Pentium recommended)
- Microsoft Windows 95, Windows 98, or Windows NT. 4.0 with Service Pack 4 or later
- 16 MB of RAM for Acrobat on Window 95 and Windows 98, 24 MB of RAM for Acrobat on Windows NT (32
MB recommended)
- 32 MB of RAM for the Paper Capture plug-in (64 MB recommended)
- At least 100 MB of available hard disk space
- Additional 50 MB of hard disk space for Asian Fonts (optional)
- A CD-ROM drive

System Requirements for Acrobat Reader 4.0 Windows
- i486 or Pentium processor-based personal computer
- Microsoft Windows 95, Windows 98, or Windows NT 4.0 with Service Pack 4 or later



- 8 MB of RAM on Windows 95 and Windows 98 (16 MB recommended)
- 16 MB of RAM on Windows NT (24 MB recommended)
- 10 MB of available hard disk space

Installation Instructions
Installing and Uninstalling Acrobat 4.0 for Windows
To install Acrobat 4.0, follow these steps:

- Uninstall Acrobat 3.x and Acrobat Reader 3.x using the uninstaller available through the Start menu.
- Make sure you have at least 75 MB of available disk space for a Typical installation of Acrobat 4.0.
- Install Acrobat 4.0 and, if desired, Acrobat Reader 4.0

Notes: If you uninstall Acrobat 3.x after installing Acrobat 4.0,  you will need to reinstall Acrobat 4.0 for it to
work properly. If the 3.x uninstaller fails to work properly, manually delete the file Uninst.isu from your
Acrobat 3.x folder then reinstall Acrobat 3.x and uninstall.

Uninstalling Acrobat 4.0 and Acrobat Reader 4.0
Acrobat and Acrobat Reader can be removed using the Adobe Acrobat 4.0 uninstaller which is available
through the Start menu. If you uninstall Acrobat 4.0, you will also automatically uninstall Acrobat Reader 4.0
because they share common files.

Installation Issues
If Acrobat 4.0 installer or uninstaller fails to work properly, manually delete the file Uninst.isu from Program
Files\Common Files\Adobe\Acrobat 4.0\95 or 98 or NT then reinstall Acrobat 4.0 and uninstall.

If the Acrobat 4.0 installer fails to complete an installation due to a lack of disk space, and you have changed
the Typical installation using the Custom installation screens, the installer may be calculating the available
disk space incorrectly. Quit the installer and manually check the amount of available disk space in the
Windows Explorer to verify that you have adequate disk space to install the portions of Acrobat you have
selected..
[277439]

PDFMaker installation issues
Adobe PDFMaker is an Acrobat tool that enables you to create PDF files directly from Microsoft® Word 97
or Microsoft PowerPoint® 97. If you install Microsoft Office after installing Acrobat, you must reinstall
Acrobat or do a custom install of PDFMaker to ensure that PDFMaker is properly installed for use with
Microsoft Word and PowerPoint.

If PDFMaker for PowerPoint does not automatically add it's icon to the toolbar upon installation of Acrobat
4.0, then to add it to the toolbar:
1. From the PowerPoint Tools menu choose Add-Ins.
2. In the Add-Ins dialog click Add New... button.
3. Select PDFMaker.ppa (not PDFMakerA.ppa) within the Macros\Office97 directory of the Adobe Acrobat
directory.
4. Click the OK button.
5. If prompted with a macro warning, click the Enable Macros button.
6. Notice that the PDFMaker icon is now on the toolbar.
7. "Close" the Add-Ins dialog box.

Once PDFMaker for Microsoft Word is installed, a PDFMaker icon will appear on the toolbar. Once you use
the icon to run PDFMaker once, a new “Create Adobe PDF” menu item will appear under the File menu.

After uninstalling Acrobat, to remove the create PDF menu and toolbar icon from Word and the PDF toolbar
icon from PowerPoint use Customize... under the Tools menu of each of these programs.
[279793]

Installing the Asian Font Packs for Acrobat 4.0
Asian Font Packs are available for Acrobat Reader 4.0. With any language version of Acrobat Reader 4.0,
you can display Adobe Portable Document Format (PDF) files that contain text in Chinese Simplified,



Chinese Traditional, Japanese, and Korean (CJK). If the author of a PDF file embeds CJK fonts in the
document, then any language version of Reader 4.0 will be able to display the CJK text on any system
without additional software. If the author uses CJK fonts but does not embed them in the document, then
you will need access to the correct Asian fonts in order to view the PDF file on non-native systems. All you
need to do is install the appropriate Asian font pack for use with Acrobat Reader.

The Asian Font Packs are available on the Acrobat 4.0 product CD in the Acroread folder, or from Adobe’s
web site at:
http://www.adobe.com/prodindex/acrobat/cjkfontpack.html

STSong™ is a trademark of ChangZhou SinoType Technology Co., Ltd

Acrobat 4.05 Maintenance Release Information
Acrobat 4.05 is a maintenance Release to Acrobat 4.0.

The following new issues apply to the 4.05 Release. Issues that were present in the Acrobat 4.0 Release
follow in the “Acrobat 4.0 Troubleshooting Issues” Section below.

Acrobat 4.05 and Office 2000 support

Acrobat 4.0 shipped before the final release of Microsoft Office 2000, and there are incompatibilities in the
integration between these two programs. Acrobat 4.05 corrects these problems. PDFMaker will correctly
integrate with Office 2000 and convert documents from Word, Excel and PowerPoint in to PDF files.  Please
re-install Acrobat 4.05 after you have installed Office 2000.

PDFMaker will convert a standard Word file (.doc) from Office 2000 into PDF. However other types of
documents available in Word 2000, such as email messages or web pages, will not be converted by PDF
Maker.  To convert a Web page to PDF, please use the Web Capture functionality within Acrobat.
[322169]

The PDFMaker toolbar icon will not function correctly if Word 2000 is in maximum view (full screen) mode.
Please change Word back to regular viewing mode to use PDFMaker.
[324605]

Acrobat 4.05 and Windows 2000 support

Acrobat 4.05 has been tested extensively with pre-release versions (through RC2) of Windows 2000.
Viewing and printing of PDF files operate correctly in the versions of Windows 2000 available for testing.
Creation of PDF files works correctly when Acrobat is installed and used by a regular user. Difficulties may
arise if Acrobat is installed by an administrator and used by a different user, or if used in guest mode.

When the final version of Windows 2000 ships please check the Adobe Technical support web page for
additional information about Windows 2000 compatibility issues with Acrobat as they are discovered.

Known Issues:

Windows 2000 PostScript Printer Driver: Acrobat 4.05 does not contain a PostScript Printer Driver for
Windows 2000 since the final version is not yet available. Consequently, the Distiller printer (a virtual
printer that creates a PDF file) will be set up only if you have a Windows 2000 PostScript Printer Driver
(the Microsoft “Pscript driver”) already installed on your system.  Therefore, to automatically setup a
Distiller printer, please install the Microsoft Windows 2000 PostScript driver by setting up a PostScript
printer and then re-install Acrobat 4.05.

Guest Mode: Acrobat, PDFWriter and Distiller will not function correctly when logged on as Guest under
Windows 2000.  The workaround is to log on as a regular user.
[320983][323746]

Windows NT with Service Pack 4 or above is recommended



Acrobat 4.05 will install the AdobePS 5.1 PostScript printer driver on Windows NT. Adobe has certified this
driver for use on NT with Service Pack 4. Adobe recommends that you update to SP4 or above for use with
Acrobat.
Following are some known issues with the AdobePS 5.1 driver and SP3: problems determining from
Windows GDI whether the application wants a TrueType host font downloaded or a printer font used, and
certain Japanese-specific font compatibility problems.
[314328]

PDFMaker may not work correctly with Word 97 if the SR2 update is not installed.
[305131]

Automatically Opening Microsoft Office files in Acrobat
The ability to automatically open Microsoft Office files and convert to PDF by opening from within Acrobat or
by drag- and-drop on to Acrobat requires Office 97 or above.  Office 95 is not supported.
[304494]

EPS files and Photoshop’s Color Management option
To successfully incorporate EPS files created by Photoshop in a PDF file, and export to EPS,  Photoshop
Duotone EPS files must be saved with the PostScript Color Management option selected.  PhotoShop
CMYK EPS files must not have the PostScript Color Management option selected.
[297619]

Errors when printing PDF files saved from InDesign 1.0
PDF files created by InDesign 1.0 will sometimes give an error when printing to PostScript Level 2 and Level
3 printers.  The workaround is to create the PDF from InDesign using Distiller, or print from Acrobat to a PCL
printer, or print from Acrobat using Print As Image.
[323742]

Distiller JPEG compression fixed
In Acrobat 4.0 the JPEG compression quality was the same for High and Medium and Low.  This was
corrected, and now images are compressed, in most cases with better results than in Acrobat 3.0.
[318631]

Prologue.ps and epilogue.ps must be used together.
In the Distiller Options section of the Acrobat guide, the use of the files prologue.ps  and epilogue.ps with
Distiller is discussed. These files must both be used together.
 [305648]

The instructions for setting up an additional Distiller Printer are incorrect
From the Acrobat Guide, pp. 105 – 107, the instructions should read:

"To set up an additional Distiller printer to use the AdobePS driver and the Distiller PPD (Windows):"

The instructions for this section need to be changed as follows:

1 Choose Setting > Printers from the Windows Start menu, right-click on the default Distiller printer,
and choose Properties.

2 Select the Ports tab.
3 Click Add Port, select PDF Port, and click New Port.
4 Select an output folder for the new Distiller printer from the browser, and click OK.
5  Launch the setup utility for AdobePS Printer Driver from the Drivers folder on your Acrobat CD.
6  Follow the online instructions to progress through the introduction, accept the license agreement,

and copy the setup program to your local disk.
7 Choose Local Printer as your printer type, and click Next.
8 Locate the Xtras folder in your Acrobat Distiller folder, select an Acrobat Distiller PPD in the list,

and click Next.
9 Select your new PDF Port (directory) in the list of ports, and click Next.
10 Follow the online instructions to proceed with the setup, and click Exit when you are finished.
11 Choose Settings > Printers from the Windows Start menu.
12 Do one of the following:

•  In Windows 95 or 98, right-click the printer you want to use, and choose Properties. Click the
Fonts tab, click Send Fonts As, choose Type 42 (for TrueType fonts) or Outlines (for Type 1



outline fonts) from the pop-up menu, enter 1 as the threshold, and click OK. Click OK in the
Properties dialog box.

•  In Windows NT, right-click the printer you want to use, and choose Document Defaults. Click
the Advanced tab, select TrueType Font Download Option under PostScript Options, select
Automatic or Native TrueType (for TrueType fonts) or Outline (for Type 1 outline fonts, and
click OK.

Note: Entering the threshold value in Windows 95 or 98 ensures that TrueType fonts will not be
converted to Type 3 fonts in a PostScript file. Type 3 fonts can cause PDF files to be unnecessarily
large. Instead, the fonts will be converted to Type 42 or Type 1.

[323367]

On Windows 95 you may need an OLE Automation Fix to run the Paper Capture plugin
Some early versions of Windows 95 may need an OLE update in order to run the Paper Capture plugin
successfully. To update OLE automation on your system, please go to the Microsoft website at
http://www.microsoft.com/ and search for "OLE Automation Fix" or install Internet Explorer 4.0 or greater.
[298727]

Catalog message: Recreated since the index was last built
Doing a Search may cause a catalog index to be recreated. To prevent this, please set the index to Read-
Only in Catalog.
[312868]

Form fields to appear rotated after replacing a page with a different orientation
If you replace a page in a PDF with a new page that has a different orientation, the form fields from the
original page end up in the same position in the new orientation.
A workaround is to select all the form fields and copy and paste them into the new document, rather than
replacing the whole page.
[305846]

Some Words in Central European languages in a TrueType Font are broken up.
Some words that contain a mixture of Roman letters and Central-Eastern European-specific letters will not
be recognized as a single word, but will be broken up into pieces within a PDF. A Find operation will not
recognize the pieces as a single word.
[306798]

On CJK operating systems, Web Buy identifier strings are displayed incorrectly in Preferences
Web Buy is distributed only in Acrobat 4.0 English, and is not localized into other languages. If installed on
non-English operating systems, some strings will not be displayed correctly.
[318517]

With no text on a page, incorrect orientation on NT 4.0 from Word 97 and AdobePS 5.1x
When a landscape page containing no text is printed from Word 97 with the Distiller printer, the page rotates
90 degrees. When text is added to the page the page prints correctly in landscape orientation.
[323964]

PDFMaker does not support all of Microsoft PowerPoint transitions
There are certain types of PowerPoint transitions that are not supported by PDFMaker. These transitions
have no equivalent in PDF. In particular, PDFMaker does not support Slide Show>Rehearse Timings.
[324026][324037]

Automatic open and conversion of PDF files does not support CMYK or LAB image files
Opening a non-PDF file from within Acrobat, which automatically converts the native file to PDF, will not
convert an image file that contains CMYK or LAB color-space information. Please use Distiller to create PDF
files with such images.
[324040]

Automatic open and conversion of PDF files from FrameMaker files will not work if FrameMaker is
running
Please Exit from FrameMaker and then open a FrameMaker file from within Acrobat, or create a PDF file
from FrameMaker using the Distiller printer.



[324498]

PDF ports need to be created below the root level of a drive
If you add a PDFPort at root level on your system, then you will not be able to use the port with the Acrobat
Distiller printer. For example, please do not choose "C:" as the location for a  new PDFPort; instead choose
“C:\temp” .
[324048]

Acrobat 4.0 Troubleshooting Issues

VIEWING

Using Acrobat 3.0 or Acrobat Reader 3.0 to view and print files created in Acrobat 4.0
You can use Acrobat 3.0 or Acrobat Reader 3.0 to view and print PDF files created with Acrobat 4.0, taking
note of the following.
 *  If you are viewing PDF files created with Acrobat 4.0 that contain Asian language text, you will need to
view and print these files with Acrobat 4.0 or Acrobat Reader 4.0.
 * If when creating PDF files using Acrobat 4.0 the default settings in Distiller were changed to take
advantage of advanced PDF features for color management or high quality printing, you will need to view
and print these files using Acrobat 4.0 or Acrobat Reader 4.0.
* If you are authoring PDF forms in Acrobat 4.0, you will need to design these forms with backwards
compatibility in mind for it to work reliably in version 3.0.(see the Forms JavaScript Guide for details)
*  If you are viewing PDF files created with Acrobat 4.0 that contains mark ups such as highlighting,
underlining, strikethrough, pencil strokes, etc. and these mark ups have associated text notes, you will need
to view these files with Acrobat 4.0 or Acrobat Reader 4.0 to be able to double click on the markings and
open and view the text notes. (General Text Notes applied to a document can be opened and read with no
issues in version 3.0)
*If you are using Acrobat 3.0 or Acrobat Reader 3.0 to search an index created with Acrobat 4.0 Catalog,
you should obtain document information from the General Info dialog (accessible by selecting
File>Document Info>General) rather than the Document Info dialog (accessible from Edit>Search>Results).
In some cases, these dialogs may differ slightly.
[273764]

Using Acrobat 4.0 for Windows with Internet Explorer
When using Acrobat 4.0 or Acrobat Reader 4.0 with Internet Explorer, take note of the following issues:
* If you double click on links in HTML files to PDF files, Internet Explorer may hang.  To avoid problems, be
sure to single click on these links.
* For PDF files to be displayed within Internet Explorer, they need to have the .pdf extension.
* Once you have opened a password protected PDF file in Internet Explorer, you may not be asked for the
password if you open the file a second time. This is because the file may be cached.
* To view PDF files on your local file system or network server, use Acrobat outside of  Internet Explorer.
Although it is possible to view these files directly within the browser, you will likely encounter problems.
* Within the web browser window, Acrobat is designed primarily for viewing and filling out forms. To use
interactive features of Acrobat 4.0, such as annotations, digital signatures, etc, you will need to run Acrobat
as a helper application or outside the web browser entirely.

Using Acrobat 4.0 for Windows with Netscape Navigator
When using Acrobat 4.0 or Acrobat Reader 4.0 with Netscape Navigator, take note of the following issues:
* In order for changes to the Acrobat/Netscape integration to take effect, such as setting the Acrobat
General Preference  for Web Browser Integration, exit and restart both Acrobat and Netscape Navigator.
(This preference lets you select whether Acrobat runs as a helper application or an inline plug-in.)
*Netscape 4.5 does not support display of PDF files from some secure servers.  PDF files transferred
through secure servers that do not support byte-serving  cannot be displayed.
* Within the web browser window, Acrobat is designed primarily for viewing and filling out forms. To use
interactive features of Acrobat 4.0, such as annotations, digital signatures, etc, you will need to run Acrobat
outside of the web browser.
*If you open a PDF file in Netscape 4.x and it appears to hang, you may be encountering a known spurious
Netscape 4.x bug. Try reloading the PDF document in Netscape.  If this does not work, use the browser’s
“Save As” menu item to save the PDF file to your local disk, then use Acrobat to open it directly from the
local disk.



[288751]

Internet Control Panel required for Adobe Online, Web Capture, and Online Registration
If you cannot connect to a Web server to Register Acrobat 4.0, use Adobe Online or use Acrobat's Web
Capture feature (only available in the full product), and you are certain your Web server is up and working,
you may be running a proxy server which is not configured properly in the Internet Control Panel. To resolve
this issue:
  * In the Start Menu, select Settings, Control Panel and look for "Internet".
  * If you have an Internet Control Panel, double click on it and go to the Connections Tab. Verify the settings
in the tab are properly configured for your environment.  ( You can verify this outside Acrobat by attempting
to use Internet Explorer to access the Web. Note: Netscape Navigator does not use the Internet Control
Panel)
* If you do not have an Internet Control Panel, you may obtain one by installing a copy of Microsoft Internet
Explorer 3.0 or later

[282722]

Adobe Online, Web Capture, and Online Registration special firewall considerations
Acrobat usually cannot connect directly to the Internet through a firewall, which is a software and hardware
barrier protecting computers on a network from being accessed by computers outside the network. Acrobat
can connect to the Internet through a firewall, though, if you configure your computer's Internet proxy
settings to allow it. Contact your network or web administrator for the proxy settings you need to use. After
you specify proxy settings, the online utilites should function properly.

How to make sure the Euro character will always appear in a PDF
If a PDF uses the Euro character but does not embed the font that includes this character, and this PDF is
viewed on a system that has an older version of the font installed where the Euro character is missing,  the
PDF will be missing all occurrences of the Euro character. To prevent this problem from occurring,  when
you create a PDF that requires the Euro character, be sure to embed the font.  If you  are viewing a PDF
with missing Euro characters, consider updating the fonts on your system to a newer version that contains
the Euro character.
[288428]

Links in PDF documents should follow proper cross-platform conventions
To reliably create cross document links that work when a PDF travels to a Windows, Macintosh or UNIX
machine, make sure your PDF links only to files with names that follow the ISO 9660 convention.  This
includes the need for file names to be uppercase, 8.3 format, and use a limited character set (no slashes,
spaces, and high ASCII characters).
[288966]

Guidelines for creating worldwide PDFs using the Number Pages feature
When using Acrobat's Document > Number Pages feature to apply special page numbering schemes to a
document, first consider the destination of your PDF.  If you are creating a PDF in an Asian language
version of Acrobat and expect the PDF to be read by others who are running Roman language versions of
Acrobat, on the Page Numbering dialog only enter Prefixes using Roman language characters. Asian
characters may not view and edit properly on Roman systems.
[278010]

Changing monitor color settings may affect Acrobat
If you change the number of colors your monitor displays while Acrobat is running, restart Acrobat to be
certain your PDF files will display with the correct colors.
[288721]

Details about how ATM affects Acrobat's Font Info dialog
When ATM is installed on the system,  Acrobat's Font Info dialog may occasionally have no entry for  the
Type field.  This occurs if a bitmap font is used.

Tips for moving pages within a document that uses multiple page numbering methods
When a PDF document contains multiple page numbering methods, if you move a page between sections
using differing methods, the page number will not be updated. To fix this, select Document > Number Pages
and renumber the entire document using one page numbering method, then create new sections with
differing methods.
[277533]



Use newest Matrox or ATI video card drivers for reliable viewing of all PDFs
If you encounter problems viewing PDF files when using Matrox or ATI video cards, consider upgrading to
the newest video drivers. Contract your video card manufacturer for updates. An updated driver will very
likely fix the problem.
[288703]

Viewing black & white images under standard VGA mode
If you are using standard VGA display mode, uncheck the "Smooth Text and Images" option in the General
Preferences dialog (File > Preferences > General) to view black & white (1 bit) images in PDF documents.
Otherwise the images may display as all white or all black.
[297406]

Viewing and printing PDF files in languages that Acrobat does not directly support.
If you create PDF files in Roman languages, Traditional Chinese, Simplified Chinese, Korean, Japanese,
Hebrew, Arabic, Cyrillic, and Eastern European languages and you choose not to embed all fonts, Acrobat
can display and print files on any system where these fonts are installed. If you create PDF files in Roman
languages, Japanese, Traditional Chinese, Simplified Chinese, Korean and you choose not to embed all
fonts, Acrobat can display and print files even if the fonts are not installed on the system, as long as the files
are in a Roman language or you have installed Acrobat's Asian Language Font Pack.  If you create PDF
files in languages other than those mentioned above, Acrobat needs the PDF files to have the fonts
embedded in order to display or print them properly. We strongly recommend that for maximum document
portability and fidelity that you embed all fonts.
[291335]

Acrobat 4.0 handles Times, Helvetica and Courier font families differently than version 3.0
Acrobat 4.0 handles fonts differently than version 3.0. These changes will not affect most users, however if
you want more information on this subject, go to the Adobe support database at
http://www.adobe.com/supportservice/custsupport/main.html and search for document #322792.

PRINTING

Re-distilling Acrobat's PostScript output will produce PDF files in which text is not searchable
We recommend that you do not print to a PostScript file from Acrobat and distill it.  If you do, please select a
directory for the output file that is different from the directory containing the original PDF.
[291665]

Tips for printing PDF files to low memory printers
If you are printing a PDF file to non-PostScript printer with a small amount of RAM (for example, 2 MB), the
printer may run out of memory.  If this occurs, you have three options:
 * In Acrobat's Print dialog, select Properties and change the print resolution to something lower, like 300
dpi.
 * Upgrade the memory in the printer.
 * Use the "Print as image" setting in Acrobat's Print dialog.
[285296]

Verify printer Properties after changing printers
If you switch from a monochrome LaserJet set at 600dpi to a color DeskJet printer, verify that the printer
Properties are reset to 300dpi, which should be the default for color DeskJet printers. If needed, reset the
dpi to an appropriate value.
[291271]

How to make sure PDFs with custom page sizes print as expected
The default Acrobat printing behavior is to scale the PDF page to fit the paper size. If you do not want your
PDF scaled to the current paper size, follow these steps. In Acrobat's print dialog, uncheck Fit To Page, then
select Properties and choose the correct paper size.
[286072]

Tips for printing to the HP LaserJet 5 and 5M

http://www.adobe.com/supportservice/custsupport/main.html


If you are having trouble with the HP LaserJet 5M Standard driver on Windows 95 or Windows 98, we
recommend downloading the HP LaserJet 5M Enhanced driver from HP's website.  Alternatively, for
Windows 98 you can use the Universal Printer driver with the HP LaserJet 5 or 5M printer.
[275249]

Use the enhanced drivers that come with the HP LaserJet printer
HP LaserJet printers often come with Standard and Enhanced drivers.  For the best results when printing to
LaserJets from Acrobat use the Enhanced drivers.
[281592]

Using the Print As Image option may eliminate printing problems
If Acrobat fails to print a file correctly, try selecting the Print As Image option in Acrobat's Print dialog. This
option, which tells Acrobat to send a 300 dpi raster image to the printer rather than vector art, may enable
troublesome files to print. This option is not, however, recommended for general purpose use because it
may make many PDF files print slower.
[289026]

How to make sure N-up printing works in Acrobat with a PostScript driver
If you have not done a Typical install of Acrobat, and you have not installed Acrobat Distiller, you may not
have the AdobePS printer driver on your system. If you print from Acrobat using the Microsoft PSCRIPT
PostScript printer driver, which is the likely scenario if you do not have the AdobePS driver installed,
Acrobat's N-up printing option will not work.  The N-up printing option, which allows you to print multiple
pages on one page, is only available if you print from Acrobat using the AdobePS printer driver. AdobePS
can be installed independently from the Acrobat CD-ROM, or in conjunction with Acrobat Distiller using the
general Acrobat installer.
[284943]

Printing Even/Odd pages and Reverse pages do not work together
 [296097]

Problems when printing or viewing complex or merged PDF files
Merging documents using insert pages may result in documents which may exceed the available memory in
the printer because of possible font duplication. Possible workarounds include:
1) Use “Print as image”.
2) Documents to be merged should have font subsetting turned off.
3) Large documents should be created in one Distiller run as opposed to merging chapters. (Refer to

“Combining multiple PostScript files into one PDF file” page 115 in the online version of the user guide.)
For FrameMaker users, use the create book feature when generating large documents instead of converting
individual chapters to PDF and then merging chapters together.

Printing problems with HP4SiMX PCL printer.
Vertical lines are drawn as filled circles on the HP4SiMX PCL printer driver. Please use Raster graphics,
rather than vector graphics, for this printer.
[295061]

Character dropouts in PCL printing on Windows NT 4.0
If you notice text dropping out when printing on WinNT 4.0 with a non-PostScript printer driver, try switching
the Document Defaults option in the Advanced pane for Print Text as Graphics from off to “on.”  This will
cause text to be emitted to that non-PS printer as a graphic bitmap.
[296078]

PDF pages printed on PCL printers may not be centered
Certain DeskJet and other non-PostScript printers have printer drivers that do not have consistent margins
all the way around the page.  The left and right values generally are equivalent, but the top and bottom are
sometimes quite different.  This can result in a PDF file, or another file type, being printed with the contents
appearing to shift toward the top of the page. Try printing with the Fit To Page option turned on in the Print
dialog to alleviate the effect. This may be useful, however there is no guaranteed fix since the issue is with
the printer driver.
[283825]

Printing issues using the HP LJ 6P Enhanced and Standard drivers on Win95



Occasionally you may encounter PDF files which do not print correctly with the HP  LJ6P Enhanced and
Standard printer drivers for Win95. If this occurs, try another HP printer driver for Win95 (LJ5 or LJ4), or use
the Print As Image option in the Acrobat Print dialog.
[288457]

The AdobePS 4.2.4 driver can only print 255 pages at one time
Acrobat will only be able to print 255 pages at one time when printing with the AdobePS 4.2.4 PostScript
printer driver.
[281591]

PostScript Level 1 printing issues
Acrobat 4.0 PDFs which contain LAB based ICC images may not print correctly when printed to PostScript
Level 1 printers. To assure proper printing of these high quality color PDFs, print them to a PostScript 3 or
PostScript Level 2 printer.

Some PostScript printing options have limited availability in Acrobat
Because of driver limitiations, the PostScript printing options Print Mirror Image, Print Negative Image, Flip
Horizontal or Vertical, and Invert Image are only available in Acrobat if you check the "Print as Image" option
in the print dialog.  Alternativly, if printing to an imagesetter you can print with “Print as Image” unchecked
from Acrobat and have the image setter perform the mirror, flip and inversions.
[283953]

What to do if stroked curves appear jagged when printed
If you observe jagged curves when printing a file to a PostScript printer, verify that the option to "Use Printer
Halftone Screens" in the Acrobat Print dialog is checked.
[291355]

ANNOTATIONS

Cannot launch an attached file or sound attachment in a web browser
You can view the File Attachment or Sound icon in the Web browser with the Acrobat 4.0 plug-in.  However,
you cannot launch the file attachment or play the sound in the Web browser.
[288715]

Modification date is not updated when the annotation object is resized or moved
The modification date (displayed in the Properties dialog)  is not updated if the annotation object is resized
or moved.  It is only updated when the associated text note window is changed.
[288704]

Undo is not supported when creating new annotations
Once a new annotation is created, you cannot use Edit->Undo to rollback the creation.  You have to delete
the annotation manually.
[288707]

Annotations remain after cropping page
When you crop a page, annotations are not affected.  Annotations may validly appear in the gray region
around a page and can be placed there manually as well. This allows the page to be uncropped and have
the annotations return.
[293126]

In Annotations and Forms Helvetica and Times are substituted if not available
Although Helvetica and Times are always listed as font options in Annotations and Forms, if they are not
available they will be substituted with ArialMT and TimesNewRomanPS, which are installed by Acrobat.
[291264]

MOVIE

Use of 16-bit AIF files not recommended.
If a 16-bit AIF file with sound is added to a PDF file using the Movie plug-in, it may not play completely.
[287225]



FORMS

Creating Acrobat Forms with appropriate Y2K date fields
The Acrobat Forms plug-in implements a "date horizon" when a field is specified with a date format that only
uses two digits. If the year entered by the user is < 50 then internally forms adds 2000 to the year. If the year
entered by the user is >= 50 then forms adds 1900 to the year. This horizon is implemented so that date
calculations are correct and unambiguous.
Regardless of the internal representation, what the user has typed is sent to the server upon submit or
export of form data. Server side software should be prepared to implement a similar date horizon if form
fields have 2 digit year formats.
It is suggested, however, that authors specify a 4 digit year in a form field to prevent any perceived
ambiguity. If the field is formatted with a 4 digit year then the user must enter all four digits or an error
message will be generated.

The Euro character does not display within forms
This problem occurs because you have an old version of Helvetica and/or Times fonts without the Euro
character and you have Adobe Type Manager installed. You must either a) turn off ATM, b) disable
Helvetica and Times in ATM, or c) get updated Type 1 fonts with the Euro character.
[291324]

Forms: mailto: scheme when submitting may produce two FDF files as attachments
If the URL of a submit form action uses the mailto: scheme and the recipient of the mail message is a
Microsoft Outlook client then Outlook may show two FDF files as attachments. This is a bug in the Outlook
client and not in Acrobat.
[278779]

JavaScript console does not appear in front when using Netscape
FYI: When a PDF file containing JavaScript code is viewed in Netscape (for example, some forms in PDF),
and the JavaScript console is summoned, it appears behind the Netscape window, and is invisible to the
user.  A workaround is to view the PDF via the regular Acrobat application rather than within a web browser.
[295162]

WEB CAPTURE

Issues with Web Capture if Internet Explorer 4.0 has been uninstalled
If a machine has had Internet Explorer 4.0 (or later) uninstalled, Web Capture may not work correctly.  To fix
this problem, reinstall Internet Explorer 4.0, or follow these steps:  1) run  regedit,  2) search for
"AutoConfigURL", 3) delete this key. Note: Regedit is a powerful tool, which you must use with extreme
caution when changing registry values. Missing or incorrect values in the registry can render the Windows
installation unusable. For additional information on Regedit and Regedt32, please see the Microsoft’s on-line
Help for these utilities or the Windows Resource Kit Tools Overview Help.
[284710]

Web Capture does not support the URL type “ file:///” for directories correctly
Web Capture will not automatically generate a directory listing for a file:/// style URL that points to a directory
on the local disk.
[295701]

TABLE /FORMATTED TEXT SELECT TOOL

Issues with Table/Formatted Text Select Tool
The Table Select Tool cannot select, extract or preserve the formatting of the following type of text:
  Text with one-point font size
  Text that is in Annotations or Forms
  Text that uses a Type 3 font
  Text that is oriented at 0, 90, 180, or 270 degree
  Text that contains mixed vertical/horizontal, and/or rotated text
  Text that contains subscripts, underline, and/or strike-through
  Text that contains a "Drop Cap" mixed with regularly formatted text



Microsoft Excel may sometimes incorrectly align text that is extracted. Similarly, column headers may be
shifted and column data might not line up with the headers.
[288489]

Table Picker's drag and drop doesn't work with Corel WordPerfect or Quattro Pro?
You cannot drag and drop the selected text into Corel WordPerfect or Quattro Pro?.  Please use Copy &
Paste instead.
 [296472]

TOUCHUP

Objects opened in Illustrator via Acrobat's TouchUp Object tool may be rotated
If you use the TouchUp Object tool in Acrobat to bring a PDF page into Illustrator, occasionally it may be
rotated 90 degrees. If this should occur, simply rotate the page as desired for use in Illustrator, then rotate
the page back in Illustrator before returning it to the PDF file.
[285775]

The Touchup Object tool requires flattened images from Photoshop
When using Acrobat's TouchUp Object tool to edit images in Photoshop 5, you may add new layers to the
image in Photoshop by using the Type Tool, or an assortment of other features. To successfully return
images to a PDF document, select Layer > Flatten Image in Photoshop to create a single-layered file before
returning the image to Acrobat.
[291321]

Issues regarding the TouchUp Text tool and stroke width
If you change the stroke color of text using the TouchUp Text tool, then reduce the text size, the stroke may
become very thick and not reduce with the text size. If this should occur, change the outline color to none,
then reapply the outline color again and the stroke will appear correct.
[286312]

Tips on copying and pasting objects into a PDF page
If you select and copy an object from a PDF page using the TouchUp Object tool, be sure to paste the object
onto a page that is larger than the original page, otherwise you may not be able to see it because it falls
outside the visible area of the new page.
[292626]

Touchup Text tool bounding box may select subset of a horizontal line of text
When selecting a line of text using the TouchUp Text tool, occasionally the entire line may not be selected.
If this should occur, in many cases you can still make small edits just fine.  If you attempt to add characters
to the line and the spacing gets off, you may want to select the text box and move the text box to a more
desirable location.
[283579]

Using the TouchUp Text Tool may cause the Font Info dialog to temporarily be incorrect
If you change a font in a PDF document using the TouchUp Text tool, the information in the Font Info dialog
may not immediately reflect the change.  The old and new font names may both be listed in the Font Info
dialog until the file is saved and opened again.
[280520]

Gradient mesh is not passed to Illustrator 8
If you have artwork in a  PDF file that contains a gradient mesh that created in AI8, and you try to edit the
artwork,  the mesh isn't opened in Illustrator.  There is no workaround.
[296182]

"SaveAs" from Photoshop or Illustrator file menu doesn't update the image in Acrobat
If you edit an image or artwork in Acrobat in Photoshop or Illustrator, be sure to use “Save” rather than
“Save As” to have the image updated in Acrobat.
[294776]



SCANNING

Duplex Scanner Settings
In any scanner that supports Duplex scanning double-sided should be selected in the Adobe Acrobat Scan
dialog box only. Do not set Duplex setting in TWAIN driver dialog box if option is available.
[259723]

HP 6200/6250C
In order to ensure correct scanning through the ADF make sure you install the ADF patch on HP's web site.
The patch will upgrade HP Precision Scan 1.0 to 1.01
[284430]

TWAIN Driver Issues with a variety of scanners
In testing a variety of scanners we found a variety of issues related to TWAIN data sources and Drivers
provided by 3rd party vendors’  TWAIN drivers. Behaviors found included infinite loops, messages that
"Adobe Acrobat, Could not complete acquisition because of a problem with the device," and "Unknown
device error,"  and "... TWAIN 32, Could not open scanner device." There are a few known problems such
as inappropriate dialog boxes appearing, no dialog appearing and even systems freezing related to bugs
within TWAIN drivers and the use of an ADF (Auto Document Feeder).
If you experience these problems noted above you should check with the scanner vendor to see if updates
are available to their TWAIN drivers.
 [289478]

Using Digital Cameras with Acrobat 4
You should expect that with most digital cameras all images from the camera will be imported in one step.
This behavior is different than when scanning where a Acrobat dialog box will appear to choose Next to scan
or Done to bring the image into Acrobat.

-- Sony DSC-F1 Digital Camera Issues
Due to an incompatibility between the current  Sony TWAIN source version 1.5 and Acrobat 4.0,  you should
always select 'Done' when you receive the 'Next/Done' dialog after a transfer of images. Since the Sony
source allows the transfer of multiple images at once, the inability to select 'Next' should not hamper the
usability of the Sony TWAIN source with Acrobat. Instead, selecting multiple images will enable the user to
import them all at once without resorting to the 'Next' option.

-- Kodak Digital DC50 Camera Setup Issues
When setting up a Kodak Digital DC50 Camera for use with the Scan plug-in you should be aware of the
following:
* In the Camera Control pop-up window set both the Serial Port and the Connecting Speed to Auto Detect
and click OK.
* If communication with the camera fails the first time you might have to retry a few times before the
connection is made.
[289493]

PAPER CAPTURE

Paper Capture : Fails to Capture after large number of Pages on Windows NT.
Paper Capture may run out of memory after reading in a file of several hundred pages. Please break the
single large file into several smaller files, or use the Acrobat Capture product.
[295245]

Paper Capture requires the system TrueType font Courier New
The Paper Capture plug-in requires the system TrueType font Courier New. If this font is not installed,
reinstall it from the Windows CD before using Paper Capture.
[296978]

Images may not process with Paper Capture more than once
If you scan or import an image of 200 to 600 dpi and process it with Paper Capture to the PDF Output Style
“Original Image + Hidden Text”, note that if Downsample Images is checked in the Paper Capture
Preference dialog, you may not be able to reprocess it.
[297106]



DRAG & DROP

Information about dragging and dropping files onto Acrobat
Acrobat supports dragging and dropping four categories of files that vary slightly in behavior.
1. PDF files
2. Microsoft Office (Word, Excel, PowerPoint), FrameMaker and WordPerfect files
3. Image files (tif, gif, png, jpeg, bmp, pcx, rle)
4. URLs, HTML and  Ascii Text files

You can drag and drop files onto one of several targets, and experience varying behavior.  When you drag
and drop onto the targets below, the behavior of the four categories above will differ slightly.

1) The Acrobat icon
 Dropping any file or URL on this target will create a new document.

2) The Acrobat document window
Dropping PDF files on this target will give you the option to append to the current document.
Dropping Image, HTML, Text files and URLs on this target will automatically append to the current
document.
Dropping MS Office, FrameMaker and WordPerfect files on this target will automatically create a new file. If
you desire to append this file to your current document, consider this approach:
    Select Window>Tile>Vertically in Acrobat
    Show the Navigation Pane
    Show the Thumbnails palette for each document
    Select the thumbnails for one of the documents
    Drag the thumbnails into the Thumbnails palette for the other document

3) The Acrobat titlebar
Dropping any file or URL on this target will create a new document

4) The Acrobat thumbnail palette
Dropping PDF on this target will give you the option to append to the current document.
Dropping an Image, URL, HTML or Text file on this target will automatically append to the current document.
Dropping an MS Office, FrameMaker or WordPerfect document on this target will create a new document.

Note that if you drag and drop HTML files or URLs you do not get to specify the number of Levels to be
captured.  Consider using the Open Web Page icon for a more robust web capturing solution.
[293430]

Issues with dragging and dropping files from a network location onto Acrobat on NT 4.0
If you are using Acrobat 4.0 on NT 4.0 and you drag and drop a file from a network location onto Acrobat,
and the filename or path has a space, you will receive an error.  If this occurs, try first copying the file to your
local filesystem before dragging it onto Acrobat.
[297108]

Opening non-PDF files in Acrobat

Acrobat can open Microsoft Word, Excel and PowerPoint files, as well as Adobe FrameMaker and Corel
WordPerfect files by converting them to PDF at the time the file is opened.  To do this, Acrobat requires that
these authoring applications be present and usable on the machine where Acrobat is running. If you
encounter any problems opening these file types in Acrobat, try opening these files in the appropriate
authoring application to verify the application is installed and working properly.

PDFMAKER

Acrobat 3.0 vs 4.0 considerations



When choosing Job Options within PDFMaker for Microsoft Word, it is not readily apparent whether the PDF
file being created is Acrobat 3.0 or Acrobat 4.0 compatible.  Acrobat 4.0 can open Acrobat 3.0 files but
Acrobat 3.0 may not be able to open or print Acrobat 4.0 files. To see if a Job Options file is compatible with
3.0 or 4.0, choose it from within Distiller and look at the Job Option settings.
[292491]

PDFMaker and "Print to file" checkbox in Print dialog
After using the PDFMaker macro in Microsoft Word or PowerPoint, the "Print to file" checkbox will be
checked in the Print dialog. Uncheck it if you do not wish to print to a file when printing directly from Word or
PowerPoint.
[291979]

PDFMaker uses the Page Layout View in Microsoft Word
When PDFMaker creates PDF files, it creates PDF files as they appear in the Normal or Page Layout Views
within Microsoft Word, not the Online Layout or Outline Views.
[291983]

Where to find PDFMaker documentation
Please look inside the Help folder within your installed Acrobat folder for documentation on PDFMaker for
Microsoft Word and PowerPoint.
[292493]

Why auto-generated numbers are not included in bookmarks
If your Microsoft Word headings are prefixed with auto-generated numbers, Word treats the number as a
separate entity from the rest of the heading. When PDFMaker queries Word to obtain the heading's text,
Word does not include the number. Therefore, the bookmark that PDFMaker creates doesn't include the
number.

PDFMaker can not return control of Microsoft Word
PDFMaker does not return control of Microsoft Word while it is generating a PDF file.
[292207]

PDFMaker does not work with locked files
PDFMaker will not respond when trying to print a locked document, such as a template document. We
recommend unlocking the document and printing, or printing directly to Distiller or PDFWriter.
[296632]

Structure only level changing
Within the Bookmarks pane of PDFMaker, if you wish to change the level of an element that does not have
Bookmark checked, you must first check Bookmark for that element, change its level, and then uncheck
Bookmark again.
[291986]

PDFWRITER

PDFWriter vs Distiller
PDFWriter is often simpler and quicker to use. If you are unsatisfied with the quality of the PDF files
generated using PDFWriter, then consider using Distiller.
[291993]

PDFWriter and patterns
PDFWriter does not support some pattern types. For example some patterns from Microsoft Word or Adobe
PageMaker will not reproduce accurately in the PDF file. We recommend using Distiller if there are patterns
in your document.
[285140]

Using zcaron and Zcaron characters in Windows 98
The new zcaron and  Zcaron characters that were added to the Windows ANSI character set in Windows 98
may not display correctly in documents created with PDFWriter, please use Distiller instead.
[294739]



PDF Writer does not support text with special effects
Text with special effects, such as Shadow and Outline, applied in Microsoft Word may not print correctly to
PDFWriter. We recommend using Distiller.
[291515]

ATM Deluxe 4.0 affects font embedding and encoding with PDFWriter
ATM Deluxe can activate different versions of TrueType fonts. This can affect the way fonts are displayed by
providing data on the wrong font set. We recommend turning ATM off when embedding TrueType fonts with
PDFWriter.
[291542]

Only the first file is printed when using Explorer to print multiple files
When selecting multiple files in Explorer to print to PDFWriter, only the first file will actually be printed. We
recommend printing one file at a time, or using Distiller's Watched Folders.
[291510]

Type 1 fonts not handled correctly in WordArt
When using Type 1 fonts in WordArt, sometimes the fonts do not display correctly in PDFs generated using
PDFWriter.
[291447]

DISTILLER

PageMaker 6.5, Export PDF 2.0, and Distiller 4.0
Choosing Export PDF from PageMaker launches Distiller and specifies job options automatically.  However,
the Distiller job options available through ExpPDF.add 2.0 (Win) and Export Adobe PDF.add 2.0 (Mac) were
designed for Distiller 3.x, not 4.0.  We recommend that you simply print directly to Acrobat Distiller by
selecting it as the printer from PageMaker's print dialog.
[286036]

Auto Rotate Pages is turned off for Print/Press Optimized Job Options in Distiller
For ScreenOptimized job options setting, Distiller will automatically rotate pages according to the dominant
text orientation. This is done on a page by page basis and makes the files easier to read. For Print/Press
Optimized, this option is turned off to preserve the original orientation and layout of text and graphics for
future printing. For more information on changing the page orientation, please see Technical Note #5151,
Acrobat Distiller Parameters. This document can be accessed through the Help menu of Distiller 4.0.
[281609]

Conflict between Distiller 3.X and Distiller 4.0
It is recommended that you uninstall any previous version of Distiller before installing version 4.0. Check and
see if you have an older version of Distiller that was installed because you purchased another Adobe
software application such as Adobe PageMaker.
[265606]

Large font point sizes will get converted to bitmap on WinNT4 Distiller
Text in a point size above 75 will get converted to a bitmap when distilled.
[290268]

Separation information is preserved in the Portable Job Ticket
Distiller does not support direct interpretation of printer systems-based separations (or In-RIP separations).
When Distiller gets a PS file of this type, it will actually create a composite PDF file rather than a separated
PDF file. The separation information will be preserved and passed into the PDF file through a Portable Job
Ticket (PJTF). In the Advanced Panel of the Job Options, make sure "Save Portable Job Ticket in PDF file"
is checked. The actual separation will only take place once the PDF file is passed to a printer or application
that can take the information and apply the separations.
[281244]

TrueType fonts in Adobe Illustrator always result in bitmap fonts in the PDF



The PostScript that Illustrator generates always contains bitmap (Type 3) versions of TrueType fonts, even if
you have a PPD selected that contains a TrueType rasterizer. As a result, the PDF will print correctly, but
will view poorly, except at the exact resolution for which the font was created. The workaround is to use the
"Save As Acrobat PDF" from the Save As menu in Illustrator instead of distilling a PostScript file.
[274087]

Windows 95/98 limits page size to 129 inches
Distiller 4.0 supports the creation of PDF files with pages up to 200 inches by 200 inches in size. Due to a
limitation with page size storage in Windows 95 and 98, the actual maximum page size will be limited to 129
inches by 129 inches. The maximum page size for Windows NT and for Mac OS is still 200 inches by 200
inches.
[268654]

Paragraph borders in some colors reproduce in black in Distiller
Due to an incompatibility between some printer drivers and Microsoft Word, paragraph borders in some
colors may come out as black in the PDF.
[291280]

PS error: Is2016andT32?
Under Windows 95 and 98 if you get the PS error "Error: undefined; OffendingCommand: Is2016andT32?"
when distilling a file, either
1) Upgrade the AdobePS driver to 4.2.5 or later and recreate the PDF file, or
2) Change the AdobePS driver to send fonts as Outlines rather than Type 42 (Printers folder, Acrobat
Distiller Properties, "Fonts" tab, "Send Fonts As..." button to bring up "Send Fonts As" dialog, change "Send
TrueType Fonts As" pop-up from "Type 42" to "Outlines").  However, using this 2nd option results in a PDF
file that cannot be searched or selected.
[294675]

DISTPARM.PDF and PDFMARK.PDF
The DISTPARM.PDF and PDFMARK.PDF technical notes available from the Distiller help menu are
provided as convenient references for advanced users. The interdocument links within these two files will
not work unless you have the other documents included in the extensive Acrobat SDK document suite. You
can get more information about the SDK from the Developer Support section of the Adobe Web site
(http://partners.adobe.com/supportservice/devrelations/).
[287941]

CATALOG

Catalog indexes in Acrobat 3.0 vs 4.0
An index built by Catalog 3.0 should work without problems with Search in Acrobat 4.0.  An index built by
Catalog 4.0 will not work properly with Search in Acrobat 3.x.  Additionally, reindexing 3.0 indexes with
Catalog 4.0 may result in date problems.  Instead please build a new index using Catalog 4.0.
[287089]

Restarting a stopped or failed index build
If an index has failed to build or Catalog was stopped while trying to build it, then to rebuild the index as
follows:

1. Restart Acrobat Catalog and rebuild the index (Index Build).
2. If the Search Engine says that it could not repair the index, then go to the directory with the same

name as your index description file (the .PDX file) and remove the file COLLECTN.STP

If an index that you wish to purge needs to be repaired in order to purge it, delete the entire index from the
File Manager. The index can be deleted instead of purged since the index is not in use.
[289512]

Issues with Catalog 4.0
Please do not use high-ANSI or the "/" character in file names, index names or descriptions.

The font used by Acrobat Catalog does not support some high-ANSI characters (character codes 133
though 159). Files or folders which contain high-ANSI characters or the "/" character may not be indexed.



Catalog will not index any file beneath a directory with a path length greater than 205 characters, since this
resulting in file path names close to 256 characters. After completing the build, Catalog may claim to have
found new file(s) when in fact it did not add them to the index.

If PDF files are removed from a directory that Catalog has indexed, the file count shown under Acrobat
Search -> Indexes -> info may be out of date. Rebuilding the index should correct the information.

When more than 10 users are searching indexes on a server, the server utilization may reach its maximum,
as the server attempts to read an entire index into its cache.  The workaround is to add RAM to the Server.
[286830]

DOCUMENTATION

Correction to the Acrobat Guide's description for "Display Page to Edge"
The Acrobat Guide documentation regarding the General Preference "Display Page to Edge should say the
following: "Some applications may create PDF documents that display a thin white border around the edge
of the page when viewed in Acrobat.  Check the Display to Page Edge checkbox to prevent this border from
being displayed."

Correction to the guide “Using Adobe PDFMaker 4.0 for Microsoft Word 97 and PowerPoint 97”
This PDFMaker user guide indicates that when you install PDFMaker for Microsoft Word, a PDFMaker icon
will be automatically placed on Word’s toolbar, and a “Create Adobe PDF” menu item will automatically
appear under Word’s File menu.   There has been a small change in this installation. When you install
PDFMaker, a PDFMaker icon will be placed on Word’s toolbar, however you will not see the new File>
Create Adobe PDF menu item until you use this icon once to run PDFMaker.

FRAMEMAKER

FrameMaker 5.5.6 may not be able to import some PDF files created by Acrobat 4.0
If you save files from Asian language versions of Acrobat 4.0, or if you change the default settings for the
Roman language versions of Acrobat 4.0, you may create PDF 1.3 format files instead of PDF 1.2.
FrameMaker 5.5.6 can only import PDF 1.2 format files, not PDF 1.3. If this occurs,  recreate the PDF file in
Acrobat 4.0 using PDF 1.2 (Acrobat 4.0 compatible) settings.
[288758]

FrameMaker left open in new template
If FrameMaker is left running with a new template open, opening a FrameMaker file through Acrobat will not
work.  Please close FrameMaker or the template first and then open the files through Acrobat.
[280556]

ASIAN FONTS

Copy & paste limitations for CJK documents
Please be aware of the following limitations when selecting and copying CJK text from a PDF file and
attempting to Paste it into another application:

1. The name of the font will be different, unless PDF font name matches exactly the name of the font on the
operating system. In general, PDF files that have been created by the Distiller will have font names that do
not match font names on the OS. To workaround this problem, please select the text after it has been
pasted, and change the font to that desired.

2. Because of the way the Adobe PostScript driver creates a bold effect of a font ("synthetic bold"), text will
actually appear multiple, overlapping times in a PDF file.  Copying and pasting such text will not produce the
desired results.  The workaround is to use a heavy weight font for bold text, rather than a synthetic bold.

3. Embedded Vertical TrueType text will have a line break in pasted text whenever an alpha-numeric
character appears. There is no workaround.



[294989]

Japanese WebCapture on Roman system requires Conversion setting change
In order to capture Japanese web pages on a non-Japanese Windows system, you must (1) install
Microsoft's Internet Explorer Japanese language support, (2) install Acrobat's Japanese Font support
(available under custom install, or as a separate installation), and (3) change the Japanese WebCapture
input encoding setting to something other than "None" -- (to change setting, Open Web Page, click on
Conversion Settings button, select HTML settings, and select the "Japanese" tab).
[290326]

Proportional double-byte fonts must be embedded in PDF files
To ensure that PDF files that contain proportional double-byte fonts (available only on Windows) view and
print correctly, the fonts must be embedded in the PDF.
[286970]

Multiple Asian Language use tips
When running an operating system that has support for multiple CJK locales, there may be problems when
copying text from multi-lingual PDF files that contain Chinese characters (hanzi, kanji, or hanja).  MacOS
"Language Kits" and MacOS 8.5's "Multilingual Internet Access" allow the user to enable multiple CJK
scripts. Microsoft's free "Language Packs" provide the same functionality for Windows.

The problems arise  because CIDs are mapped to Unicode values to derive content.

Some Chinese characters that are unique to a single language (or locale). For example, Unicode value
U+4E6B exists only in Korean (KS X 1001:1992 Row-Cell 42-65). Such characters are handled without
problem by Acrobat since there is no ambiguity.

However, some Chinese characters are common across the CJK languages, and there is ambiguity in
deciding what language should be chosen.  For example, the Unicode value. U+4E00 maps to Simplified
Chinese (GB 2312-80 Row-Cell 50-27), Traditional Chinese (Big Five 0xA440), Japanese (JIS X 0208:1997
Row-Cell 16-76), and Korean (KS X 1001:1992 Row-Cell 76-73). There are over 2,500 Chinese characters
that fall into this category. In such cases, Acrobat may fail to correctly identify the script (language), which
causes a mis-match between the reported script and the actual encoding of the characters that are copied
then pasted into other applications.

For example, paste such a common character into an Acrobat Note and then press ctrl-click to see what
language is selected. Pasting the same character into another application may not reflect the encoding that
is reflected by the checked script.

The work-around is to paste characters into an Acrobat Note, explicitly select (or re-select to ensure that the
encoding is correct) the script, then re-copy the text. The text can now be pasted into other applications with
more predictable results.
[294351]

CJK Notes - Changing Language of Notes can cause data loss
When you right-click on a Note a pop-up menu appears with a check next to the language that the note is
written in.  If you change this between Asian languages, or between an Asian language and Roman
language, text in the Note may be changed or lost.
[287913]

CJK PostScript Printing - Expected fonts on printer
When printing to a Chinese or Korean--enabled PostScript printer Acrobat expects certain fonts to be
installed on the printer.  If the font that is used in the document is present on the printer, it will be used; if not
then the following default substitute fonts will be used, and are assumed to be on the printer.

Korean:    /Serif /HYSMyeongJo-Medium
              /SansSerif /HYGoThic-Medium

ChineseSimplified:  /Serif /STSong-Light
/SansSerif /STHeiti-Regular

ChineseTraditional: /Serif /MKai-Medium



         /SansSerif /MHei-Medium

If this is not satisfactory, please check the "Download Asian Fonts" option in the print dialog box and the
fonts available on your workstation will be used for printing.
[289269]

CJK Switching to an English User Interface turns off some CJK specific functionality
Switching the User Interface to "English"(in General Preferences)  causes some problems with functions that
rely on CJK language resources

1.  The Find Dialog will not display the option: "Half/Full width Kana"
2.  3 Annotation buttons will appear (Highlight, strikeout and underline) that don't support vertical text
3. The text field at in Files -> Preferences -> General :  Current Language displays incorrectly
[289075]

Most CJK fonts are substituted with Serif-style fonts
If a CJK font referenced in a PDF file is not on the displaying system and the font is not embedded in the
PDF file, and the Serif flag is not set in the PDF file, then the font will be substituted for with a Serif style
substitute font.  Unfortunately, the Distiller in Acrobat 4.0 does not set the Serif flag, so most CJK fonts will
be substituted with a serif font.  If you would like to maintain the look and feel of your fonts, please embed
them in the PDF.
[293533]

Quark Xpress 3.3 Users - Do Custom Install and don't install AdobePS Printer Driver!
There is a serious incompatibility between Quark Xpress 3.3 and the CJK versions of the AdobePS 8.5
Printer Driver. To avoid this, when installing Acrobat choose a Custom Install, and do not install the Distiller
Printer.
[294599]

Thumbnails from Distiller and documents with double byte fonts
If you have double byte fonts in your document, the Generate Thumbnails joboption in Distiller will not work.
The workaround is to leave this option unchecked and use Acrobat to create Thumbnails afterwards.
[297315]

CJK Export EPS limitations
When you export a PDF file that contains CJK text to EPS via the ExportPS plugin, please be aware of the
following limitations:

1. You can use only the following type of fonts when producing an EPS file:
- Embedded and Non-Embedded PostScript fonts
- Embedded TrueType fonts

2. Synthetic Bold or BoldItalic fonts are not supported. (If a true heavier weight font is not available, the
PostScript driver will synthesize a bold effect by writing the character several times. This will produce an
EPS file with unexpected results.) Please select a true Bold typeface (heavier weight) instead of bold affect.

3. When printing the EPS file, the behavior is the same as traditional EPS: Only printer resident fonts are
used. If not available on the printer, they are replaced by Courier or Italic /Ryumin-Light. Note that this is a
different result than when Acrobat prints directly, in which case font substitution is done on the printer.
[290882]

TrueType fonts embedded in PDF files may display poorly when strokes overlap
If TrueType fonts are downloaded by the PostScript driver as Type 1 rather than Type 42, and strokes of the
font overlap, then the intersection of the strokes will display as white rather than the black that is expected.
Normally CJk fonts will be downloaded as Type 42, and if downloaded as Type 1 this may indicate a
problem in the font. Also, be sure you are using the latest AdobePS 4.2.5 driver.

Euro character will not display properly using an Asian font
Acrobat 4.0 does not support the Euro character with Asian fonts.  Please select a single-byte (Roman) font
to display the Euro character.  When selecting Euro as the Currency Format for a Forms field, be sure to
select a Roman font to display the field.
[291752]



Use Raster mode printing with HP Laser Jet 5M PCL Printer
When using the HP Laser Jet 5M PCL Printer to print PDF files with CJK text and rich color backgrounds
please use Raster mode rather than vector mode.  With vector mode the text may not appear.
[291369]

CJK PageMaker documents with Embedded TrueType fonts
When a PDF file is created from a PageMaker document and has TrueType CJK fonts embedded, text
strings in the document may be duplicated (appear on top of one another) due to the manner in which
PageMaker generated the original PostScript data. This will not affect the display or printing of the PDF file.
However, other functions that manipulate the text in the PDF file such as Touchup, copy and paste to other
applications, TableCapture, and Export EPS may not work as expected.
[291877]
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